Certifications

(C)




Certification Processes Include:

1. (C-DU) Download-Upload
2. (C-ITI) Institution Initiated
3.

(C-0) Online




To Start a Certification ....

Navigate to GLASS System

Go to https://glass.wisconsin.gov/WI/index




(C-DU) Download-Upload

Certification




(C—DU) Download-Upload Certification — Step 1

Choose values for fields indicated below. Then click bownload link.

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

1318415

MENU H 2025-2026 =
. E =
-

Financial Summary » ) Help ﬂ:l Logout

Hello,
Your Name Appears Here "

HOME > Roster Selection

You are currently working with the 2025-2026 Academic Year

There is action you must take for the rosters in the Certification Rosters section. The rosters in the
Informational Rosters section are for reference and reporting purposes.

Choose  miip

Values for
Program and
Term Fields

Program: | All Programs

SSN:
First
MName:

Last
Mame:

Student
jisH

Certification Rosters - Action Required

w

Term:

Then
Choose
Download
Link

Certifyf|Download
Onling|File (CSV)

Certification

Onlina Download

Credits and GPA

Online | Download




(C—DU) Download-Upload Certification — Step 2

From the dialog box that appears, choose a location and file name for the file download. Then click Save
button.

@ Save As
/T\

Organize ~ New folder

v @ This PC

File name: J 025-2026 Fall Certification (5).

Save as type: Microsoft Excel Comma Separated Values File (*.csv)

A Hide Folders




(C—-DU) Download-Upload Certification — Step 3

Using your File Explorer, navigate to the file that you saved in Step 3. Open it up. It should appear similar to
the be|OW A awosae @of) B D T [ 5 3002025-2026 Fall Centficationcsv v D search

Fle Home Insert Pagelayout Formulas Data Review View Automate Help Acrobat

& Aptos Narrow ~| VA E= : v b, General v {EB @ E/ B insert v

[B v : o «0 .00 Conditional Formatas Cell &5 Delete -
B I U-+ v e V = iE v $ % 9
< U o 9 % 3% Formatting v Tablev Styles ¥ [} Format v

Clipboard & Font S i & Number [ Styles Cells

Al vl S Entity ID

Entity ID _Academic Term Desc School Coc School Nai Program SISSN  Last Name First Name Middle Nar Date of Bir Program S' Annual Aw Term Awar Paid Amou Type C Certification Codes

Add codes separated by commas, or
select from the list below and click

When it is opened, edit the file, specifically these three fields: [add codes]; to just add one code,

you may double click it.

1. certification code i — = | [A=Carea 2
Certification Code [|[New AmcuntlEnmllment Sta'mﬁp I D - Review Pending
2. enroument status = E - Fully Funded - No unmet need

H - Program not eligible
3 SAP | - Non-matriculated
. - Leave of Absence
- Loan Default
Refund Owed
Selected for Verification
- Withdrawan
- Deceased
- College Placement Test Score
- Above Income Limit
Student declined award

The enrollment status and SAP fields are defaulted to F (full
time) and Y (yes). You will need to edit the default values as

applicable. You also need to enter a certification code for each 9
of the records (rows).

NZIX=<Uo0Or




(C—-DU) Download-Upload Certification — Step 3 - continued

The possible values for enrollment status will be known soon. You do not need to enter anything into
the New Amount column because the system will calculate the prorated amount.

Then, File save. After saving the File, File exit.

€

& Autosave (@ off) D~ 3~ [ =  3002025-2026 Fall Certification.csv \/
Automate Help Acrobat

Home Insert Page layout Formulas Data Review View
— b ? A & Insert v
2b, General v @] @ E-I/ &
Conditional Formatas Cell &2 Delete  ~

JA A
M@ ~
B i U] dev e $ - % 9% H
Formatting v Tablev Styles~ = [m=] Format v
Cells

& -
5} Alignment Number 5 Styles

1]
%
']

(T

A Aptos Narrow ~[11

Clipboard S Font

Jx EntityID
B C D E F G H | J K L M N O P

Al d
A
1 [EntitylD _|Academic Term Desc School Coc School Nai Program SISSN  Last Name First Name Middle Nar Date of Bir Program $' Annual Aw Term Awar Paid Amou Type €




(C-DU) Download-Upload Certification — Step 4

Go back to the Home Page and select Send Roster File.

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

13154103

2025-2026 + Financial Summary + @) Help EJ Logout

Your Name Appears Here s Hello,

[zl Institution & Students i= Reports

u- Institution Information 4 Search For Student 35 Standard Reports

=] Rosters

[ Documents & Payments 2 Data File Transfer

o Application Entry ,& Request Payment + Send Roster File

. Incomplete Applications ., Disbursements/Refunds : File Transfer Results




C-DU) Download-Upload Certification — Step 5

Select Certification. Then click Choose File.

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

2025-2026 v Financial Summary v @ Help mloqnlll

St Hello, Barbara Moermond - Institutional

HOME > Send File - Choose Upload Type

Please note that the year in which you are presently working is independent of the year associated with the data you are
uploading. Glass will verify and apply the data you are uploading against the year associated in the file.
Select the type of roster you want to send to HEAB

AChoose ONe Sl ¥

< Choose One >

You h EAB for 2025-2026 . .
_— State of Wisconsin

B Ceruncation - Instiuton-iniatea > Name

S92 et and GPA fzoeon 2025-2026 Pl Cartfication.on : Higher Educational Aids Board (HEAB)
Rkl o] LT Grants, Loans, and Scholarship System (GLASS)

Zopyright 2025 © D}QE" Public Records Act Contact Us | Sitemap | FA(
figher Educational Aids Board

2025-2026 ¥ Financial Summary v ) Help. EJLngnut
Hello, Dennis Kohlmeier - Institutional

HOME > Send File - Choose Upload Type

Please note that the year in which you are working of the year associated with the data you are
uploading. Glass will verify and apply the data you are uploadmg against the year associated in the file.
Select the type of roster you want to send to HEAB

Cerification ~

. clifl Browse and a dialog box will open.

. Firll the folder in which your file is saved. To open a different folder, click the Loak in box at the top of the dialog box.

. Highlight the name of the file you want to upload.

. clific open

. Tilfile you selected will appear in the box below. If it is correct, click Upload File. If it is not correct, click Browse and follow the
st8s above to select the correct file.

Choose File | No file chosen

Follow Steps 1 -5
S To €hoose Your File
and Click Upload File




C-DU) Download-Upload Certification — Step 6

After Choosing Upload File (Step 6), you will see:

HOME > Send File - Choose Upload Type > Send File - Confirm File Format

Roster Type: Certification
File Info: 300 2025-2026 Fall Certification.csv - 974 Records

Does the file format look correct?

[R As a precaution, you are required to confirm the file format of the file you just uploaded. Only the first 25 records will be displayed.

.. Confirm File Format & Process L Cancel File

Program Annual Term Type Campus

Entity 4 Academic Term School School First Middle Date of Program Certificatic

D Year Description Code Name Short SSN Last Name Name Name Birth Status Award  Award of Student Code
Name Amount Amount Leave ID

FOX
ALLEY
CHNICAL
COLLEGE

WG-TC Awarded

FOX

“Click Confirtm File
o “Format & Protess

FOX
VALLEY .
TECHNICAL Awarded
COLLEGE

Awarded

FOX
VALLEY .
TECHNICAL Awarded
COLLEGE

ey caL| WE-TC Awarded

TECHNICAL
COLLEGE

Awarded




(C—DU) Download-Upload Certification — Step 7

After choosing Confirm File Format & Process (step 7), you will see:

Uploading File

Your file is currently being imported
into the Glass system.

HOME > Send File - Choose

R

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

6o 2025-2026 v Financial Summary v

Your Name Appears Here sl Hello,

Upload Type > Send File - Confirm File Format > Send File - Processing

File Sent for Processing

|
|
Your file has been sent to Glass for processing. Your result files should be available for ‘
download within 24 hours. |

—>




(C—DU) Download-Upload Certification — Step 8

Go back to the main menu:

State of Wisconsin
Higher Educational Aids Board (HEAB)

HEAB Grants, Loans, and Scholarship System (GLASS)

2025-2026 = Financial Summary = 2] Help

Your Name Appears Here sl Hallo,

[l Institution & Students |=/ Reports

4_;' Institution Information —.,  Search For Student 25 Standard Reports

=] Rosters

- Documents & Payments & Data File Transfer

o Application Entry ¢4 Request Payment &+ Send Roster File

. Incomplete Applications ', Disbursements/Refunds 5 File Transfer Results

.z Options

£ Manage Users

& Edit Your Profile

—>

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

Click on file transfer results link and you
will see a list of everything that has
been completed. If you don’t see a
recently uploaded file, itisn’t done
processing yet. It may take up to 24
hours processing time, however
typically it is significantly less and may
be a short as 10-15 minutes.




(C—DU) Download-Upload Certification — Step 9

When the file processing is done, you will see a File Transfer Results similar to the below:
(Eligible, Ineligible, All Students and Exception Students)

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

FFS-FFE w Finamcial Sumamary #

OME > File Transfer Results

Diwwenboad Flle Tramsler Racults

B Besult files from 50090 2025 5:15:14 PH - 2300 johmon 2025 2026 Fall Certification, o

You should go into each of the files to review. Exceptions are records that have errors and
prevent processing. There are various reasons for errors, and an example is a bad| SAl.

For the exceptions file, typically it will be empty, but you still need to check. Overall, check
all the files.

If there are exceptions, contact HEAB for assistance.




(C—II) Institution Initiated

Certification




C-1I1I) Institution Initiated Certification — Step 1

Click on Send Roster File (shown below):

Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

2025-2026 v Financial Summary v

9 Help m Logout

Hello, Barbara Moermond - Institutional

Institution @ Students |= Reports
4« Institution Information 4 Search For Student ] Standard Reports

| Rosters

Documents ;» Payments » Data File Transfer
o Application Entry 0 Request Payment ™
Incomplete Applications Disbursements/Refunds & File Transfer Results

» Options
&) Manage Users

Edit Your Profile

From the screen that appears as shown below, choose Certification - Institution Initiated

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

2025-2026 v 4 Melp 8 1ovout

toedlo, Barbacs Moermsnd - Tnstitutional
se Upload Type

Please note that the year in which you are presently working is independent of the year associated with the data you are
uploading. Glass will verify and apply the data you are uploading against the year associated in the file.
Sele: f roster you want to send to HEAS

n - Instdonntiated v

2. R hed ) en o different
B Cenncanon - instesson-intated b to upt
ac

€l Creats and GPA
57 . - et .
s CPe0es ana GPA - Insteubon intiate

} box bedow
Choose File | No file chosen
.. Upload Fae
You have sent 2 actual data flle{s) to HEAB for 2025-2026

Dete/ Time Hoster Vype File Name

S/AW2026 $:15134 P Carnhaston Roser 303 johnasn 2025-3026 Full Centdcation cse




C-1I1I) Institution Initiated Certification — Step 2

Choose a File, then Click Open.

@ Open

GBM RESEARCH

CHILD SUPPORT FILES

D2 300 st init cert fale fall ."szmv.k $730/2025 109 PM

Grants and Scholarshps

Y, 202 ST INIT 2 Fall Certificationcsv

v 1 This B 2025-26 UAT testing WG-Tribal Semester count-GLASS.
a B3 202526 WG-PNP UAT Query Semester Count-GLASS #
= Local Disk (C
D fle_trarater 005784 eligble csv
- motrmbiod (\\Actounts watite us\!
D3 file_tracater 009744-Exceptions.cov
= HEAB (\\accounts\SASH files) (M)
09 300 2025-2026 Fall Centificationcsy
o Securefies (\\wwamadOpsi3l) (S
& refund? pna

s SETPON.
nst int cert file fall 2526.d¢ All Files {**

Open v

1. Click Browse and 5 diadog box will apen,
2. Find the folder in which your flle s saved, To open a different folder, dick the Look In

e of the Ne v

Choose File | N

, Upload File

You have sent 2 actual data flle(s) to MEAB for 20252020

Date/ Tume Huster Type Ve Name

VIWI0IE B2 04 M Contifamtion Rasier 303 Jebrmas 24 Tl Corthcmmonn ine




(C—1I1I) Institution Initiated Certification — Step 3

Click on Upload File

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

20252026 » " Help mlw

Hello, Barbara Moermond - Institutionsl

HOME > Send Flle - Choose Upload Type

Please note that the year in which you are presently working is independent of the year associated with the data you are
uploading. Glass will verify and apply the data you are uploading against the year assoclated in the flle.
Select the type of roster you want to send 1o HEAB

Choose File | 300 inst i

. Upioad File
You have sent 2 actual data file(s) to HEAB for 2025-2026

Dute) Time Roster Tyge Tide Nawe

S19/202% S15:14 M Certaston Qamter 300 jobnson 202852006 Fall Confication cav




(C—1I1I) Institution Initiated Certification — Step 4

After you choose Upload File:|

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

MENU Seanch: POXS-3036 w Finandial Seammary « g Help mln.ull

" * .
[:*-1_ — Heflo, Barbara Mosrmand - Dnstituthonal

HOME > Send Flle - Choose Upload Type > Send File - Confirm File Farmat

State of Wisconsin
b S Higher Educational Aids Board (HEAB)
gl Grants, Loans, and Scholarship System (GLASS)

As 8 precaution, you are reguired to confirm the file format of the file you just uploaded, Only the first 25 records will be displayed

. MﬂanFﬂmﬂém | .. Gancei File MEND g 2025-2026 v Financial Summary »
sap Cortited | il
Mame in Desburse

Program Campux
hcademic Term Schonl  School Ll Centifornboen Mew Enrallment
Yoar Cescrigtion Code  Mams St SN h Student g Amaunt Shatus

HOME > File Transfer Results
s

Download File Transfer Results

Result files from 5/30/2025 1:17:58 PM - 300 inst init cert file fall 2526.csv

All Students

b

Result files from 5/30/2025 9:22:30 AM - 300 2025-2026 Fall Certification.csv

xceptions Students

. " Result files from 5/19/2025 5:15:14 PM - 300 johnson 2025-2026 Fall Certification.csv
Click on Confirm Format and Process

Downloads are In CSV format. CSV files are recognized by most spreadsheet programs, including Microsoft Excel ™

When it completes it, go back to main menu.

When the process upload is completed, check the file called all process that number
processed was the number submitted. If itisn't, then check exceptions. The sum of the
exceptions and all processed in this case should equal the number submitted.




(C-0) Online

Certification




(C O) Certification — Online - Step 1

Click on Rosters (shown below):

State of Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

20252026 »

Institution

ws Institution Information

Documents

o Application Entry

Incomplete Apphcations

» Options

£ Manage Users

Edit Your Profile

. Students

Search For Student

9]

» Payments

¢80 Request Payment

Disbursements/Refunds

L

Hello, Barbara Moermoed

Reports

i Standard Reports

o Data File Transfer

¢ Send Roster File

¢ Fle Transfer Results

Imstitutionasl




(C O) Certification — Online - Step 2

You are currently working with the 2025-2026 Academic Year.

There is action you must take for the rosters in the Certification Rosters section. The rosters in the
Informational Rosters section are for reference and reporting purposes.
Program: | All Programs

Term: Fall

S5N:

First

Name:

Last

Name:

Student

ID:

Certification Rosters - Action Required

Certify Download
Online |File (C5V)

{b Download

oad

\; Certification

é Credits and GPA

Informational Rosters

View Download
Online |File (CSV)

J | Offered Roster
o Offered and Certified
b | Certified and Not Paid
Paid

~
ot
O Refund Due

When you click on certifﬂon[ine you will see the screen below




(C O) Certification — Online - Step 3 — Option A

HOME > Roster Selection > Roster

Roster: Certification

Campus: FOX VALLEY TECHNICAL COLLEGE
Program: All Programs

Academic Year: 2025-2026

Term: Fall

revious | Page1 v | Next [ (contract all)

4 ( SSN ) Student Name (Fall)

4 ( SSN | Student Name (Fall)
by

Click on expand all

save individually, you can save all at the end.

MOME > Roster Selection > Roster

(roll)

SAl Campus 10

New Torm Amount Term Award Paid

(Fall)
Al

Status Certification Codes Program  New Term Amount Term Award Pald
3 v ™ " '

Then it will save everything and then those students will drop off the online certification list
because they are certified.

Alternatively you can do this at the edit student level for roster selection




(C O) Certification — Online - Step 3 — Option B

HOME > Roster Selection > Roster

Roster: Certification

Click on View for the student you want to certify, and

All Programs
Academic Year: 2025-2026

i) see the page below .

Pr us |Page1 v | Next

4 ( SSN ) Student Name (Fall)

State ¢ . Wisconsin
Higher Educational Aids Board (HEAB)
Grants, Loans, and Scholarship System (GLASS)

&4 ( SSN ) EvtudintNamt (Fall)

Click on expand all

Financial Summary =

Hello,
HOME > Roster Selection > Roster > Edit Student

- ##H-##-#813
GLASS ID:

B  General Information
Status Cortification Cades Program
) T

oy

a

DOB: 9/6/1987

a Academic Period Information

On Hold [No v Enter a certification code
Expand All

E 300 FOX VALLEY TECHNICAL COLLEGE

Expand Al
Status Certification Codes Program

) o Annual Award Sumfhary:

Program Annual Award Certified to Date Paid to Date
e $1.790.00 30.00 £0.00
WGTC E $0.00 $0.00
Then it will save everything and then those students will drop off the online certification list TOTAL Awards  31.80.00 30,00 £0.00
because they are certified.

E  Fall of 2025-2026 Academic Year

Alternatively you can do this at the edit student level for roster selection

Enroliment Statu, SAP: SAL Campus ID: Terms To Disburse: Type of Leave: Mursing Degree Program:
Full-time ;’ Yes v | -1500 =Cl On =G o

=Cl = A =G One A ~Choose One>

Status Certification Codes Program
/e ™ $E30.00
(%] %] WG-TC $0.00

save == Then click on save button

New Term Amount Term Award
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